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Copyright note

NTE: Copyright © 1996-1999 University College London

All rights reserved.   Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the  documentation and/or other materials
provided with the distribution.

3. All advertising materials mentioning features or use of this software must display
the following acknowledgement: This product includes software developed by the
University of California, Berkeley and the Network Research Group at Lawrence
Berkeley Laboratory.

4. Neither the name of the University nor of the Laboratory may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE
REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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1 Introduction

Figure 1: Main NTE Window

NTE - unicast and multicast text editor conferencing tool. NTE can be used for
either point-to-point videoconferencing involving a direct link between two
hosts or for multiparty conferencing with many participants via the Internet
Mbone (see Box 1).

!

Unicast and Multicast

A unicast connection is like a telephone call which has one connection
between two telephones for the duration of the call. You should use
unicast if there are only two people in the conference and if one of you
does not have access to multicasting. In order to set up a unicast
connection, you must know the name of the computer that the person you
want to have a conference with is going to use.

A multicast connection can, in principle, have an unlimited number of
participants. You should use multicast if it is likely that there will be more
than two participants in the conference. Tools like RAT, VIC, NTE, WB
and SDR have been specially developed for multicasting.

Box 1: Unicast and Multicast

In other documentation, you might occasionally find NTE referred to as NT.
�

 NTE is first and foremost a conferencing tool - not a text editor. You might
think of it as a text editor with very limited functionality.

1.1 Getting started

There are two ways of starting up NTE: from the command line and from
SDR.
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1.1.1 Starting NTE from SDR

When joining a conference which uses text from SDR, NTE will start up
automatically. All parameters will be set automatically.

1.1.2 Starting NTE from the command line for a multicast conference

As with the other Mbone tools the command format is as follows:

Unix:

Prompt> nte [options] <address/port>

Windows95/NT4.0:

Click on the Start button in the bottom left hand corner of the screen.
Select Run... In the Run Window, type the following in the open: field.

Open: nte [options] <address/port>

The multicast address should be in the range 224.2.0.0 - 224.2.255.255
(except when using admin scope – see Box 2). The port number should be at
least 5002.

So, as an example, this line would start NTE with a TTL of 48 (see Box 2 for
an explanation of TTL) on the multicast address 224.2.3.70 and port number
5004:

Prompt>/ Open: nte -t 48 224.2.3.70/5004

In the example above the user has used the option ‘-t’ to specify the TTL. TTL
determines how far the packets will go, i.e. how far away you can
communicate with people using NTE. A TTL of 48 is generally large enough
for communication within the UK.

�
 All participants must use the same multicast address and port number in

order to “see” one another in NTE.
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!

TTL

TTL stands for Time To Live and determines how far the audio that you
transmit will travel. A TTL of 15 will reach other parts of your campus, a
TTL of 47 will reach all parts of the JANET Mbone, a TTL of 63 reaches
Europe, and 127 worldwide.

The default for all the Mbone tools is a TTL of 16.

Admin scope

There is currently a move away from using TTL for scoping conferences to
using admin scopes. Using admin scope will limit conferences more
accurately and is more sophisticated than specifying a TTL.

Like TTL scopes, admin scopes need to be set up by the network
administrator. When the scopes have been configured, you will get a
range of addresses for each of the scopes defined. Using an address in
the range provided will limit your conference to that scope.

Example: If local scope is defined as addresses in the range of 239.0.0.0 -
239.100.255.255, any conference on addresses in this range will be
restricted to the local area as defined by the network administrator.

The most widely used method for scoping is still TTL, so you should
contact your local systems administrator to see if admin scopes have
been set up. If not, you should ask them to do it.

Box 2: TTL and Admin scope

1.1.3 Starting NTE from the command line for a unicast conference

As with the other Mbone tools the command format is:

Unix:

Prompt> nte [options] <remote_hostname/port>

Windows95/NT4.0:

Click on the Start button in the bottom left hand corner of the screen.
Select Run... In the Run Window, type the following in the open: field.

Open: nte [options] <remote_hostname/port>

So, as an example, this line would start NTE for a unicast conference with
someone on the computer called myhost.example.ac.uk on port number 5004:

Prompt>/Open: nte myhost.example.ac.uk/5004

The person at the other end, in this case the person who is working on
myhost.example.ac.uk will have to do the same command but with the name
of your computer instead of myhost.example.ac.uk.
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TTL is not applicable in unicast sessions.

1.1.4 Quick guide to using NTE

Text typed in or imported into NTE by other participants will automatically be
displayed in the Main NTE Window (see Figure 1). If the text takes up more
than one screen, you can use the scroll bar on the right of the text area to
scroll up and down.

In order to write in NTE, click anywhere in NTE and start typing. The text will
begin where you clicked.

You can edit text by clicking on the text that you want to edit and then using
the keyboard to make the changes.

You should now be able to use NTE for taking part in conferences.

2 NTE user guide

All the text in NTE appears in the main editing window - the big white part of
the Main NTE Window (see Figure 1). Text in NTE is treated as blocks. The
whole Agenda in Figure 1 constitutes a block of text.

To create a block of text, simply click with the left mouse button on a blank
space, and start typing. If the screen is full and you cannot use the scroll bar
to move further down the document a block of text should be created right at
the bottom of the screen and the Enter key on the keyboard can be used to
create more space for typing.

A block of text can be manipulated in different ways:

• You can change the colour of the block by selecting the block, clicking on
it and choosing a colour from the Colour menu at the top of NTE. Colours
are primarily to distinguish between different people editing the same
document.  You cannot set parts of a block to different colours - only the
whole block. You can give your pen a default colour by choosing a colour
from the Colour menu before you type anything.

• You can change the font into italics and/or bold by selecting the block,
clicking on it and choosing a font from the Font menu at the top of NTE.
The limited selection of fonts is to enable documents to be saved as plain
text, without the problems that would result from variable width fonts. The
different font styles are available to help distinguish different users’ texts.
You can only change the font of an entire block, not parts of it.

• You can move a block by selecting the block, clicking on it and dragging
the block of text with the middle mouse button (or both mouse buttons at
the same time on a two-button mouse if using Linux, or Ctrl & left mouse
button if using Windows95/98/NT4.0).
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• You can delete a block by selecting the block, clicking on it and selecting
Delete Block from the Edit menu at the top of NTE.

• If two blocks of text are on top of one another, you can lower the block on
top, i.e. make it go in the background, by selecting the block by clicking on
it and selecting Lower Block from the Edit menu.

To edit an existing block of text, select the block of text by clicking on it with
the left mouse button. It is possible to edit the text of others as well as your
own -unless they have locked their contributions.

Several people can work on the same block of text at the same time.
However, a block can only have one colour, font and location at any one time,
so it is not possible to highlight one person’s contribution to that particular
block by using a different colour or font.

When the Current Block Info option in the Show Menu is selected, a line is
visible underneath the menu at the top of the screen displaying information
about the block which you have currently selected. It will tell you the block id
number, who created it, who last edited the block, and when it was last
changed. A padlock after the block id tells you whether the block is locked or
not. If it is locked, only its creator can edit the block.

!

Attracting Attention in the Text

If participants have to scroll to see the whole text because it is bigger
than the window it is displayed in, there is no easy way of making sure
that everybody is looking at the same part of the text. If you want to
draw everybody’s attention to a certain place in the text, you can hold
down the right mouse button which will display a pointer on everybody
else’s screens - but only if they are already looking at that part of the
text!

If another participant is pointing to a part of the NTE which is not
currently displayed in the window, a stripe, the same colour that the
participant is currently writing with, will appear in the document map
(Displayed in the bottom right hand corner of the Main NTE Window)..

Alternatively, you can mark the text by inserting special characters like
a row of exclamation marks which can be easily found when scrolling
up and down the text.

It is generally a good idea for each participant to write with a different
colour so that it is easy to identify who is writing what.

Box 3: NTE - Attracting Attention in the Text
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!

Not enough space on your screen?

You can save space on the screen by deselecting the Participants
and/or Current Block Info options in the Show menu.

You can also make the NTE window smaller and then use the
scrollbars to view hidden text.

Box 4: NTE - Not enough space on your screen?

2.1 Saving and loading text

It is possible to save the blocks of text in NTE in a file for later reference. It is
likewise possible to load plain text files into NTE.

• You can save text by choosing Save Plain Text from the File menu. (The
Save Structured Text option is not available.)

• You can load text by choosing Load Plain Text from the File menu.
However, there is a limit to how big a text file you can load. If the file is too
big, it will automatically be truncated. (The Load Structured Text option is
not available.)

If you load two or more texts, they will all appear in the top left hand corner
of the window, so you will end up with two or more texts on top of one
another. You can move the texts by grabbing a block with the middle
mouse button  (or by holding both mouse buttons down at the same time
on a two-button mouse if using Linux) and dragging it to where you would
like the text to be positioned.

! If there is more than one block of text, there is a risk that the blocks may
be aligned differently in other participants' NTE.

2.2 Different views.

If you find the size of the text too small, the view menu provides alternative
enlarged views of NTE’s main window.  Selecting an enlarged view will
increase the text by the specified percentage.  The scrollbars will be adjusted
so that text that cannot be seen (to the bottom and right hand sides) is still
accessible.
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!

NTE Mouse Bindings

Left Mouse Button: edit an existing block, or create a new block if no
existing one is under the pointer.

Middle Mouse Button (or both mouse buttons at the same time on a
two-button mouse if using Linux, or Ctrl+left mouse button if using
Windows95/NT4.0): Grab and move an existing block.

Right Mouse Button: By holding down the right mouse button, a pointer
visible to the other participants will appear. When you right click, the
pointer on your screen will say me, but to everybody else, the pointer
will contain your user name (see Figure 1).

Box 5: NTE Mouse Bindings

2.3 Participants panel

If the Participants option in the Show menu is selected, a column will appear
at the right of the screen, containing a list of participants, a small control
panel, and a document map.

• At the top, a list of the participants in the conference is shown in their
current colour.  When a participant has not been heard from recently, their
name is displayed in grey, and will eventually be removed. If the Keep
button is selected, participants will remain in the list of participants despite
no longer being active.

• Underneath the list of participants is a small control panel giving you three
options.

If you select Read only, you cannot write anything. This is a useful option if
you do not wish to accidentally write or delete something in NTE.

If you select Lock New Items, only you can edit and delete the blocks that
you have created. This only applies to blocks created while this option has
been selected. The option is useful if you want to import or type in some
text which you do not want anybody else to edit or delete. If anyone apart
from the creator of the block attempts to edit your text they will see a small
padlock symbol.

Encrypt Sessions allows you to encrypt the text in NTE so only participants
with the right password can read the contents of NTE. You will be asked to
enter a password for the session if you select this option.  Then whenever
other users wish to join the session they will have to enter the correct
password before being allowed to join.

• The grey and white square at the bottom right hand corner of the screen is
a document map. The white area represents the part of the document
which is currently visible. If the document map is all white, you are seeing
the entire text on the screen. But as the text gets longer, you will need to
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use the scroll bar to move around in the text, and the white area in the
square gets smaller. The bigger the document, the smaller the white area.
If the white area is at the top of the square, you are looking at the top of
the text. The document map will give you an indication of when other users
are modifying the document in an area that is not locally visible by
displaying a coloured bar where the editing is taking place.

2.4 Other options

The options menu allows certain features to be turned on or off.  The default
settings are recommended.

• Participants List:  This will toggle the frame on the right-hand side that
contains the list of participants and the activity window.

• Current Block Info:  This will toggle the current block status bar, situated
just underneath the menu items.

• Checksum Protocols:  The checksum protocol creates an extra layer of
checking to make sure that blocks are synchronised between other NTEs.
It may be advantageous to turn on this option if network conditions are
poor.  For it to work correctly all participants should have the option turned
on.

• Deselect blocks when idle: If on NTE will automatically deselect blocks of
text after 60 seconds.  If the ‘Minimise screen updates’ option is also on
then text that isn’t selected will only be updated once a second.

• Minimise screen updates:  If on NTE will only update blocks of text once
per second unless the block is current selected in which case it is updated
as changes are received.

You can access help text by clicking on the Help button in the top right hand
corner of the Main NTE Window.

2.5 Multilanguage support on Windows 95/98/NT4.0

Support for Multilanguage character sets is available if you have installed the
MS Windows Multilanguage support. Up to date details are available on the
NTE web page:

http://www-mice.cs.ucl.ac.uk/multimedia/software/nte/
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NTE Command Line Options

-t TTL
Specifies the TTL (time to live) value set in the packet headers. This limits the scope of
the packets. The following values are generally considered appropriate:

16 campus/organisation
47 country
64 continent
127 world

-bl max_block_length
Specifies the maximum number of lines which can be imported into NTE in one go. Files
larger than the specified maximum will be truncated. Use this option to override the
default setting if you need to import large text files.

NOTE: As no data compression is implemented in connection with loading text files,
extreme caution should be taken when using the -bl flag, as you risk flooding the network
by importing files which are too large.

-display display
Sets the display, enabling you to run NTE on a remote machine.

-p, +p
If you set the +p flag, the participants list and document map will be visible on start-up. If
you set the -p flag, it will be hidden.

-C session_name
Sets the title bar of the NTE window to session_name.

-N user_name
Sets the name with which you will be identified to the other participants. You cannot
change your name from within NTE.

Box 6: NTE Command Line Options

NTE Synopsis

Nte [-t TTL] [-p ¦ +p] [-bl max_block_length] [-display display] [-C session_name]
[-N user_name] [multicast address[/port]]

Box 7: NTE Synopsis
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2.6 Known bugs

�  Problems with inserting blank lines into documents.

�  Retransmission protocol still incomplete - if last person to make a change
leaves a conference, no retransmissions happen until someone else
changes something.

�  Prolonged network partitions may not resolve themselves immediately.
This means that if the network breaks, NTE may not be updated properly
when the network comes back up.

�  Dynamic block length calculation is not always correct - sometimes stars
which are supposed to indicate lost lines appear at the end of complete
blocks, or the last line of a block gets duplicated.

�  Multiple instances of NTE running on one machine do not perform
correctly

�  Odd things happen when multiple mouse buttons are held down
simultaneously.

�  Blocks of text which appear aligned in one NTE may not appear aligned in
another participant’s NTE.
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Further Reading

NTE

Handley, M. and Crowcroft, J.  1997. Network Text Editor (NTE): A
scalable shared text editor for the Mbone. Proceedings of ACM
SIGCOMM ‘97, Cannes, France.
See also: ftp://cs.ucl.ac.uk/mice/nte/

Mbone

For further information about the JANET Mbone service, see the
JANET Mbone Service Technical Guide. The guide is available from:
http://www.ja.net/documents/mbone3.4.ps
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Glossary

IP address
IP (Internet Protocol) addresses are unique numerical identifiers for each networked
host computer. The IP address is used in conferencing when the conference is point-
to-point rather than multiparty.

LBL
Lawrence Berkeley Laboratories, University of California, Berkerley, USA.

Mbone
The multicast capable backbone of the Internet. It currently consists of a network of
tunnels linking the islands of multicast capable sub-networks around the world.

Multicasting
Multicasting is sending audio, video etc. on the Internet in way which ensures that
anybody who is interested in receiving the information, can receive it, but only people
who are interested will receive it. Think of it as being in between unicast (like most
telephone calls - between two telephones only) and broadcast (TV - the signals are
sent to you whether you want to watch or not).

Multicast address
Addresses used for multicast conferencing should be in the range 224.2.0.0 -
224.2.255.255
Note: Multicast addresses must be agreed upon in advance of the multicast session,
either through e-mail or phone or assigned using SDR.

Network congestion
A condition in an IP network where the amount of traffic injected into the network is
too great for the routers to handle and some packets are discarded.

Port
A UDP (User Datagram Protocol) number unique to the broadcast session, and
should be over 5000.
Note: The port number must be agreed upon in advance, either through e-mail or
phone or assigned using SDR.

Protocol
A set of standards that govern the transfer of information between computers over a
network or via telecommunications systems. To reduce errors, the computers at both
ends of a communications link must follow the same protocol.

Receive-only
A condition where a tool is used to receive information, but cannot transmit.

SDR
Multicast Session Directory.

TTL
TTL stands for time to live, and determines how far multicast packages can travel
over the Internet. The standard values are:
16 - Site
47 - UK
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63 - Europe
127 - World

Unicasting
A unicast connection is a point to point connection between two specific machines.

WB
Whiteboard.


